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A note to the reader: As you read through this document, you may come across some terms you would like more information on. There are hyperlinks in this document that link to the Appendix that give you that information. For example, it defines a word, explains an acronym, etc. To go to the hyperlink target, hold down the Ctrl key and click the hyperlink. To return to the place you left from, press hotkey combination Alt-left arrow.

Accessing EpiTrax: If outside of the State of Nevada network and for non-state employees, a Multi-Factor Authentication (MFA), called RDWeb through the NV DPBH IT office, may be necessary to protect and keep secure all Patient Identifiable Information and Patient Health Information (PII/PHI) data.

Browser Note: The EpiTrax software functions better with Mozilla Firefox or Google Chrome. It will function with Microsoft Edge and Internet Explorer but not as well.

Note: At times during use of EpiTrax, you may encounter a drop-down list of predefined items from which to choose, for example a facility, and the item you need is not in the list. When this happnes, please contact your system administrator by emailing NVEpitrax@health.nv.gov.

c

Email the new NV DPBH EpiTrax email: NVEpitrax@health.nv.gov

For Support
c

Epitrax will time after 15 minutes of inactivity, avoid this by selecting Save and Continue often (located in the top right). 
Save and Continue
c

Please submit an email to NVEpitrax@health.nv.gov to request the addition of a Performing Lab, Hospital or other medical Facilities. 
**Note: Providers (Doctors, etc.) can be added by the user in EpiTrax.


Adding Lab, Hospital or Facility
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[bookmark: _Toc116472480]What is EpiTrax?
EpiTrax is an open source, highly conﬁgurable, comprehensive surveillance and outbreak management application designed for public health. It allows local, state, and federal agencies to identify, investigate, and mitigate communicable diseases, environmental hazards, and bioterrorism incidents.
EpiTrax imports electronic laboratory reporting (ELR) and electronic case reporting (eCR) to create a new Case Morbidity Report (CMR), same as a case or investigation. It offers sophisticated analysis, visualization, and reporting of contact and case information.
EpiTrax increases overall effectiveness in preventing morbidity and mortality through decreased reporting time, automated assignment and routing processes with bulk workflow options, easy form-creation tools, trend analysis, detection of anomalies, and quality assurance.
[bookmark: _Toc116472481]Why use EpiTrax?
Per Nevada Administrative Code (NAC) 441A), certain infectious diseases must be reported to the Nevada Division of Public and Behavioral Health (DPBH). Within DPBH, the Office of Public Heath Investigations and Epidemiology (OPHIE) manages EpiTrax. EpiTrax is an internet-accessible database that is configured to receive reports for most communicable diseases and electronic case reports (eCR) from clinicians and laboratories. Once a laboratory or case report enters a CMR in EpiTrax, it is filtered to the appropriate disease classification (e.g., STI/STD, tuberculosis, general communicable disease) and routed to the appropriate jurisdiction or local health department (LHD) based upon the zip code of the patient. The LHD accesses the patient’s record in EpiTrax and is able to perform disease investigation and contact tracing, or other disease mitigation actions required by DPBH or the LHD.  All LHDs can access EpiTrax online. 



[bookmark: _Toc116472482]Settings & Alerts


 

[bookmark: _Toc116472483]Settings
[image: This is a snapshot of the Epitrax menu bar]

When you log into EpiTrax the ﬁrst time, you will want to go directly to SETTINGS menu on the far right of the top green menu bar.
General User Information

[image: Image of general user information ]
Fill in all the user information fields. This will ensure that alerts are sent to the user email listed and that user’s phone and email are displayed inside the event records of EpiTrax.








The SETTINGS menu is also where you go to LOGOUT of the system. Users must LOGOUT after working in EpiTrax or at the end of the day for security purposes to ensure the open session is closed.


[bookmark: _Toc116472484]Alerts
[bookmark: _Hlk109110426]Alerts will be generated by the electronic laboratory automation system and will be emailed daily. This can occur only if the user’s information is ﬁlled out in the General User Information under the Settings tab.

Examples of alerts that can be setup include: 
· New laboratory record added (positive)
· New disease event created/routed
· New attachment added to an investigation


[bookmark: _Toc116472485]Task User 
Tasks can be a useful tool in EpiTrax for managing your investigations. They can be created or EpiTrax will auto-set a task and/or send an email alert for a variety of changes in a case.  

You will be able to set your own configuration in the Task User Settings grid.  If the agency has set certain tasks globally for your agency, you will receive the tasks and/or emails through that setting.  Remember to go to the General tab to check your email address is current if you have selected to receive emails.

Customizing Task User Settings

A. Select pencil to edit task and alert settings
B. Make selections. Selecting Email Alert will result in emails sent in real time.
[image: Image of the task user setting grid]B
A

C. Once selections are made click the checkbox 

[image: Image of the task user settings]



Note: Certain tasks will be grayed out as they are dependent on the current user’s roles and privileges and may not be options for opt-in task alerts.

[bookmark: _Toc116472486]Task Agency
[image: Image of task agency settings]

The Task Agency tab is visible to agency administrators or designated persons. If an administrator or designated person selects a task alert, it is not optional for agency users, unlike alerts in the Task User tab. 



[bookmark: _Toc116472487]EpiTrax Navigation

 



[bookmark: _Hlk109132733]

[bookmark: _Toc116472488]EpiTrax Dashboard
Home
2
1
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[image: Image of Epitrax dashboard]3
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The EpiTrax Dashboard is the ﬁrst screen you will see upon logging into your account. The dashboard is a ‘to-do’ list to display tasks. 

There are four main portions to note on the dashboard:

1. Menu—This will be used to access different portions of the system.
2. Login Verification —This section will display your name upon login. 
3. Header—This will display the heading for the portion of the system you are accessing.
4. Tasks —This will display tasks you have established within various CMRs. These tasks have been assigned to you by either yourself or others such as a team member or supervisor. Tasks are described in more depth on the next page.
Note: You may return to the Dashboard view or “home” at any time by clicking on the EpiTrax logo in the upper left-hand corner.











[bookmark: _Toc116472489]Setting up Task List Views within Dashboard
The Tasks Dashboard is your landing page and when you login to EpiTrax, it functions as a ‘to-do’ list to display tasks. Tasks are created under the Notes tab by either yourself or others such as a supervisor or team member, tasks can be managed (reassigned or marked as complete) directly from the dashboard. In addition to assigning tasks from an open case, the system can autogenerate tasks for you depending on your preferences. For example, if you wanted Epitrax to assign a task to you each time you are listed as an investigator. 

The dashboard is not a list of all your morbidity and/or contact event records. A list of your events can be viewed in the Events section. The EpiTrax system does not automatically generate the task list on your dashboard. You must set up what tasks you want to display on the dashboard by following the instructions below: 
1. In the Dashboard view, click the View Options button in the right-hand corner.
 [image: image of the dashboard view]
2. Enter the view options you wish to use by populating the fields below:
A. Enter a due date range (9/04/2021 – 02/28/2022 used as example)
Note: If you leave the date fields blank, EpiTrax will show tasks with any due date, as long as they meet the remaining filter criteria. Tasks with no due date will be displayed regardless of the date criteria you select.  



B. Diseases: select as many diseases as you want to include (COVID used as example)
C. Investigating agency: Select the correct Investigating AgencyNote: If only “Pending” is selected, tasks marked “Complete” will drop off the view.

D. Assigned to: Select the Investigator you wish to filter by
E. Status: Select status (Pending, Complete, Not applicable) 

A
B
C
D
E


When you have selected your preferred view options, you can either: 
1. Click on Update to update your current dashboard view temporarily. 
2. Or click Set Default to save your selections as your default dashboard view that will display each time you open EpiTrax or return to the dashboard screen.
[image: Image of dashboard ]
Next Step:
A. Tasks meeting the outlined criteria will appear. 
B. To enter a record select the case number.
[image: Image of dashboard]B
A

[bookmark: _Toc116472490]
Steps to Create a New Confidential Morbidity Report (CMR)
Nevada regulations require laboratories to send lab results for notifiable diseases to the state therefore, DPBH has accepted the responsibility for laboratory report entry into EpiTrax.
Sometimes, local investigators receive reports from medical providers and need to enter investigation notes before a laboratory report is processed at the state level. For these situation, LHD users can create a New Confidential Morbidity Report (CMR) (also known as “adding an event”) without having to wait for DPBH to create one.

1. Click the New CMR menu link located at the top of the page.
[image: Image of dashboard highlighting new cmr option]
2. Before creating a new CMR, search to see if the person is already listed in the database. Enter as much information as you have and click the Search button.Note: You MUST enter at least four characters for the first AND last name to retrieve results. If either name is less than four characters, you MUST enter the full name 








[image: Image of new CMR fields]

3. Clicking the Search button will display a list of all existing person records in the database that partially/fully match the search criteria. The list will be sorted in descending order based on the “Score ratings”. The score ratings with maximum numbers of highlighted stars are the best matches for the searched names. Moreover, the birth date along with the maximum score ratings indicates that the listed person matches very closely to the searched person.




To view more details of a person in the list, click on the row with the person’s information. This will show three new tabs: Demographic, Events, and Labs.


4. Please review the existing CMR(s) before creating the new CMR to avoid duplicate entries. Please note that you will be able to see only the Events for which you have permission (e.g., you will not see STD/STI events if you do not have permissions for STI/STD events). To add the new CMR: 
A. If the person does not exist in the system, click the +Create a new person and CMR button
B. If the person is in the system, then click the +CMR button attached to the person record
[image: Image of New CMR fields highlighting the add a new person and CMR button]A
B



5. This will bring a new window to create a new CMR for the searched person. Click the Save & Continue button after entering all of the following:Note: If you only have permissions for one agency in the system, you will not see the Investigating Agency field. The agency will automatically be set for you.

· First reported to public health 
· Disease 
· Investigation Agency for the person to create a new CMR. 

Click the Cancel button to cancel creating a new CMR
Click the Save & Continue button to save the new CMR and continue to the next screen

A
B
C












[bookmark: _heading=h.2s8eyo1]
[bookmark: _heading=h.17dp8vu]

[bookmark: _Toc116472491]Edit Morbidity Events

After creating a New CMR and clicking the Save & Continue button on the upper right, the Edit Morbidity Event page comes up.

[image: Image of the edit morbidity event ]

The top part of the page will always display the record number, event type, workﬂow status, investigator, disease, investigating agency, state case status, LHD case status and event date for the person.

If an investigator is assigned, clicking their name will show the investigator contact info including phone number and email. 



[bookmark: _Toc116472492]Routing Event to Another Jurisdiction 
Sometimes an event will get assigned to your jurisdiction but needs to be routed to another jurisdiction or is an out of state case. 

You can assign to another jurisdiction from the events page:
1. Select the flow dropdown and then select route to LHD
[image: Image of the flow dropdown ]
2. Select the agency you wish to send the event to and press Route to LHD: 
[image: Image of workflow action, specifically the agency dropdown ]

You can also assign to another jurisdiction from within the event (it looks very similar to the above scenario):
1. Select workflow options:
[image: Image of the workflow options ]
2. Select Route to LHD
3. Select the agency you wish to share the event to and press Route to LHD


[bookmark: _Toc116472493]Unlocking An Event
[bookmark: _heading=h.26in1rg]If you open an event and notice you are unable to edit fields, the person is likely locked. 

[image: Image of the morbidity event highlighting the person locked feature]

To resolve this:
1. Select the Person Locked arrow to see who has locked the event. Often this will be yourself and you have just accidentally left the record without saving it. 
2. [image: Image of the force unlock buttons]If it is another team member, reach out to them to and ask to be notified when they are finished working with the record. If you were to force unlock and edit while someone else is working in the record you would disable their access and their changes would not be saved. 
3. Once it is safe to access the record, select force unlock and edit. 
1. 

[bookmark: _Toc116472494]Primary Menu Items
Options, Workflow Options, View and Navigate menu items are listed on top of the page for easy navigation.

[image: Image of primary menu items]

Options: the primary purpose of this menu item is to share, add, edit, or delete the morbidity event. Sub menu items under this menu are:
[image: Image of the edit morbidity event section ]

	Options
	Description 

	Agency Sharing 
	Select Edit Sharing under Agency Sharing to add another jurisdiction from the available list. The event can be shared with multiple jurisdictions, and all jurisdictions with which the event has been shared will be able to edit the event.

	Demote
	Click to demote the CMR event to a contact event. Within the contact event you can also promote the contact to a CMR. 

	Copy to new event
	Click to copy the details from current event to a new event for the person. To copy certain sections from the current event, mark the check boxes in the pop-up box.

	Add Task
	Click to add and assign a task (e.g., task for a call back to a patient on the day isolation ends).

	Add Attachment
	Click to add an attachment under this event (e.g., a laboratory report or medical records pertaining to the event).

	Import Events
	Events may be entered into an Excel file. Select Import Events. When “Leave Site” window pops-up, select Leave. From the Event Import page, click on the Options menu item, and select Download Template. This will download an Excel file onto your local system. Open the ﬁle - all the header ﬁelds will be set in the top row and should not be altered. Enter data in subsequent rows in the .xlsx ﬁle (a separate row for each Event). Save the file to your local computer. Then from the Options menu, select Upload Import File to bring the data into EpiTrax. From the drop-down, choose either the Morbidity Event type for new Morbidity Events or Contact for new Contact events.

	Delete Events
	Click to delete current event.

	Edit Person
	Click to edit demographic details or to view lab, vaccine, treatment, or other person related histories or view other events for the person (refer to EpiTrax Edit Person section in the manual).




Workflow Options: The primary purpose of this menu item is to manage the workﬂow of the morbidity event. Sub menu items under this menu item are:

[image: Image of workflow options] 


	Options
	Description 

	Workflow Status
	When the CMR is first created, this item says Accept Event. Once the Event is accepted, it will transition the Event through the different workﬂow statuses.

	Route to LHD 
	Click to route the event to a different local health department.

	Do Not Investigate
	Click to ﬂag the current event as “Not for investigation”. This option is not available once the event has been accepted.

	Workflow History
	To view the list of users who created or edited this morbidity event along with date/time and jurisdiction.




[bookmark: _heading=h.1hmsyys]View: The primary purpose of this menu item is to view different sections of the event page or toggle the event menu items between accordion view or tab view. The default is set to tab view. To toggle the view from the event tabs to accordion view, select Show Accordion from the menu. Once Accordion view is selected, the menu item will change to Show Tab.
[image: Image shows the view options]

If the view is set to Accordion, the screen will be as shown below. 
Note: There will be additional sub menu options under View menu items to open or close all sections. The option to change the Accordion view to Tabs view will also be available.
[image: Image of morbidity event highlighting the open or close all features]
Navigate: The primary purpose of this menu item is to navigate to the Events page or People page.
[image: Image of the navigate to people or events dropdown options]

[bookmark: _heading=h.41mghml]
There are four buttons on the right side of the edit morbidity event page – Accept Event, Print to PDF (printer icon), Save & Continue and Save & Exit.

[image: Image of event and workflow options ]B
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D



1. Event Investigation Status: when the CMR is first created, the first button will say Accept Event. Once the Event is accepted, the first button changes to the next stage in the workflow of the Event, for example, Assign To Investigator. The investigation status can be changed by clicking on the box through each of the investigation statuses.
2. Print: To print to PDF the entire event page or selected event tabs.
3. Save & Continue: To save new details within the event and notify other users the record is currently in use. Some fields are triggered variables and will only populate after the “parent” variable is saved, such as pregnancy status would only populate in female events therefore the sex field would need to be populated as female and saved.
Note: To remain active in the event, save frequently to prevent the record from “timing out”. For security reasons “timeout” will occur 10 minutes after the last save attempt. Not saved within last 10 minutes? User will be forced to reload the event and re-type the information again.







4. [bookmark: _heading=h.2grqrue]Save & Exit: Once this button is clicked, the event page will be changed to view only mode. The option to edit the page will be available as Edit Event. Click on Save & Exit when ﬁnished with an event record. This action will ensure the record is unlocked for use by other users.

[image: Image of the view morbidity event feature]
[bookmark: _heading=h.35nkun2]

[bookmark: _Toc116472495]EpiTrax CMR Search

Select CMR SEARCH from the top header menu to find and view or edit an existing CMR.

[image: Image of the CMR search feature]

A basic search can be done by entering names, date of birth, phone number, or record number. A search can also be performed using the CMR ‘Record number’ field, such as 202200145, as shown below.

Enter as much information as possible to get an accurate list. Click the Search button or press Enter to get the list of matched CMRs.

[image: Image of the CMR search section]



To open a record, click on the link under the Record Number column shown in the box above.

An Advanced Search can be done by clicking on the Advanced Search bar to add more details like city, county, age, condition, jurisdiction etc., for the searched person. The purpose is to narrow down the search list.
[image: Image of CMR search]
At the very bottom of the ‘Advanced Search’ menu is a toggle switch to allow users to include deleted records in any given search. By default, deleted records will not be included. To include deleted records, switch the toggle on (green), as shown below.
[image: Image of the show deleted events option][image: image of the show deleted events section once toggled to be on]
The entire result list can be exported to a CSV file by clicking the Export button at the bottom.
To export only certain columns from the result list, click the Export bar, select the needed columns, and click the Export button.

[image: Image of export options]

[bookmark: _Toc116472496]EpiTrax CMR Tabs

 



[bookmark: _Toc116472497]EpiTrax Demographic Tab

Demographic is the ﬁrst tab in the Edit Morbidity Event page.

This tab can also be opened from the View  ->  Demographic menu located at the top left of the page.

The purpose of this tab is to enter/edit the personal contact information of the patient, including: Name, Age, Addresses, Telephones, Email addresses, Demographics

[image: Image of view dropdown]

Name: The last name and ﬁrst name of the person will be auto populated from the create NEW CMR action. Person’s last name is a required ﬁeld. Edit the names if needed and click the Save & Continue button on the upper right.
[image: Image of save and continue function ]

Age:
A. Date of birth: The ﬁeld will be auto populated if entered while creating the new CMR for the person. Add the date of birth if the ﬁeld is empty.
B. Current Age, Age at Event values will be auto calculated based on the date of birth and event date entered for the person. Age at onset will be auto calculated based on Onset date (check Clinical section). The auto calculations do not take place until after clicking on Save & Continue on the upper right. 
B
A

[image: Image of age fields]
[bookmark: _heading=h.vx1227]
Addresses:
	Street: Enter the house number and street name (e.g., 123 Generic Street).
Unit Number: Enter the apartment, space or unit number or the multi-family housing complex number, if applicable.
	City: Enter the full city name, unabbreviated.
	State: Select the state by clicking the drop-down arrow. 
	Zip Code: Enter 5-digit zip code.
	County: Select the county by clicking the drop-down arrow.
	Earliest Known: Enter the date when the address became valid for the person.
	Moved: Enter the date when the person moved from the given address.
	Type of Residence: Select type of residence (e.g., apartment, dorm, barracks).
	Note: enter additional information about the address (e.g., parent’s house)Note: Once all address information is entered, click on Save as Address at Diagnosis button. To add another address, click +Enter Address button.




[image: Image of save as address at diagnosis field ]


If there are existing addresses for the person in the system, they will be displayed at the lower part of the Address sub section: 
A. Current 
B. Address at Diagnosis
C. Options to mark or remove the Address at Diagnosis will be available.

[image: Image of addresses ]C
A
B



Note about country of residence at diagnosis

This is a triggered field that is required by CDC if an individual was out of the country at diagnosis.  
To enter country of residence in EpiTrax:
A.  Note “out of country” in the State dropdown. 
B. Then Save & Continue
C. Select correct country














[bookmark: _heading=h.3fwokq0]




Telephones: This section is for adding the contact information for future follow-up with the patient. Multiple telephone numbers can be added, once you select save & continue another empty field for telephone number will appear.

Telephone Type: Select the telephone type of the phone from the drop-down list.
Area Phone, Ext: Enter the area code, phone number and extension. Extension is optional.
[bookmark: _heading=h.1v1yuxt]Country: Enter country code. For the USA, enter 1.

[bookmark: _heading=h.4f1mdlm][image: Image of telephone section ]

Email Addresses: This section is for adding the contact information for future follow- ups with the patient by email. Multiple email addresses can be added.
Email Address: Enter email address.
To save, click Save & Continue button on the upper right. This will bring another empty field for an additional email address.

Demographics: This section is for adding additional demographic information for the patient.
Birth Sex: Select the birth sex of the person.
Current Gender: Select the current gender of the person.
Primary Language: Select the primary language the person speaks.
Translator Required in Healthcare Setting: Select correct answer.
Ethnicity: Select ethnicity from the drop-down list.
Race: Select the race values from the check box list (may check more than one).
Country of Birth: Select the country of birth from the drop-down list.
Click Save & Continue button on the upper right.

[image: Image of Demographic section ]

[bookmark: _Toc116472498]EpiTrax Clinical Tab
Clinical is the second tab in the Edit Morbidity Event page. This tab can also be opened from the View -> Clinical menu located at the top left of the page.

This tab is to enter clinical information such as: Disease, Relevant Comorbidities, Hospitalized Status (can specify Health Facilities and Clinicians), Mortality Status, Pregnancy, Treatments, and Vaccines. 

[image: Image of clinical tab]

Disease: This section contains information on the disease, date the disease symptoms ﬁrst appeared, and date the person was diagnosed with the specific disease.

Disease: This drop-down ﬁeld contains a list of diseases to choose from. The ﬁeld will be auto populated with the initial disease selected for the person while creating the new CMR. If that disease was wrongfully entered, select a new one from the list. Make sure to click the Save & Continue button located at the top right corner of the page.

Changing the disease will also change the Disease name at the top header in the Edit Morbidity Event page.
[image: Image of disease condition ]
Onset Date: This ﬁeld shows the date when the disease symptoms were ﬁrst identiﬁed in the patient. Enter/edit the date of disease onset. Make sure to click the Save & Continue button located at the top right corner of the page.

Once the date is saved, the Age at Onset ﬁeld under Demographic tab will auto populate with the calculated value using this date.

Date Diagnosed: This ﬁeld shows the date when the patient was diagnosed with the disease. Enter/edit the disease diagnosis date. Make sure to click the Save & Continue button located at the top right corner of the page.

Relevant Comorbidities: This section contains information on conditions associated with the disease. You can directly go into these comorbidities if they are listed with an investigating agency you are assigned to.
[image: Image of relevant comorbidities ]

If there are no relevant comorbidities, the system will display the message: ‘No relevant comorbidities found.’
[image: Image of the relevant comorbidities section]



Below is a table that lists the relevant comorbidities that are configured in the system:
	Nevada Comorbidities

	Condition
	Listed Comorbidities

	Chlamydia
	Gonorrhea
Syphilis
HIV

	Gonorrhea
	Chlamydia
Syphilis
HIV

	Syphilis
	Chlamydia
Gonorrhea
HIV

	HIV
	Chlamydia
Gonorrhea
Syphilis
Hepatitis B, Acute
Hepatitis B Pregnancy Event
Hepatitis B Virus Infection, chronic
Hepatitis B Virus Infection, perinatal
Hepatitis C, acute
Hepatitis C, chronic
Hepatitis C, perinatal
Meningococcal disease (Neisseria meningitidis)

	Hepatitis B, acute
	Hepatitis C, acute
Hepatitis C, chronic
HIV

	Hepatitis B Pregnancy
	HIV

	Hepatitis B virus infection, chronic
	Hepatitis C, acute
Hepatitis C, chronic
HIV

	Hepatitis B virus infection, perinatal
	HIV

	Hepatitis C, acute
	Hepatitis B, acute
Hepatitis B virus infection, chronic
HIV

	Hepatitis C, Chronic
	Hepatitis B, acute
Hepatitis B virus infection, chronic
HIV

	Hepatitis C, Perinatal
	HIV

	Meningococcal disease (Neisseria meningitidis)
	HIV

	Multisystems Inflammatory Syndrome in Children (MIS-C) associated with COVID-19
	Coronavirus Disease 2019 (COVID-19)


Facility / Clinician / Hospitalized Status: This section records clinician and hospitalization status. 

To add a facility and clinician, select the +Facility/Clinician button. If the patient was admitted to multiple health facilities, you can select this button multiple times to add more.

[image: Image showing the facility, clinician and hospitalized status section]

Facility / Clinician / Hospitalized fields: 
Visit Type: Visit type of the patient in the facility due to the related disease can be Inpatient, Outpatient or Unknown. Select appropriate value from the drop-down list.
Disease Caused Hospitalization?: This ﬁeld will be available if the inpatient visit type is selected. Select from the drop-down list whether the patient had to be hospitalized due to the disease.
Health Facility: Enter as much of the facility name as possible and press Enter. 

[image: Image of facility, clinician, hospitalized status section on the clinical tab]

After you press Enter, the system will search for the available list of facilities in the database. Select the appropriate facility name. If the facility you are searching for is not on the list, contact your system administrator to get the facility added.

[image: Image showing facility search results]
Click Save & Continue on the upper right once the health facility is selected.

Fields under the Facility / Clinician / Hospitalized section (cont.):
Type: The ﬁeld will be auto populated if the details are in the database for the selected facility. Please note, this ﬁeld will be populated only after clicking on Save & Continue on the upper right.
Address/Phone: The ﬁeld will be auto populated if the details are in the database for the selected facility. Please note, this ﬁeld will be populated only after clicking on Save & Continue on the upper right.
[bookmark: _heading=h.2u6wntf]Transmission Facility?: Select Yes/No/Unknown if the facility is the transmission facility (this may or may not appear depending on disease type).
Diagnosis Facility?: Select Yes/No/Unknown if the facility is the diagnosis facility (this may or may not appear depending on disease type).
Clinician: Enter the name of the clinician and press Enter.
This will bring the list of clinicians in the database. Select the appropriate name from the list. If the name is not in the list, click +New button to the right of the clinician ﬁeld to add a new clinician name and click Save Clinician button.
Visit Start: Enter date when patient was admitted to the facility.
Visit End: Enter date when patient was discharged from the facility. 
Medical Record Number: Enter medical record number for hospital visit.
Facility Comment: Enter generic comment regarding the facility visit.
Please do not provide any disease speciﬁc comments as this ﬁeld is visible in the person record (therefore visible to anyone investigation any condition for the person).
If the patient was admitted to multiple health facilities, click on the + Facility / Clinician button to display additional ﬁelds.

Mortality Status: This section is to record mortality status.
Died?: Select Yes/No/Unknown from the drop-down list.
Date of Death: Enter date of death if “Died” is marked as Yes.
[image: Image of mortality status section]Note: After selecting yes, additional fields may appear depending on the condition (e.g., death record number).




Pregnancy Status: This section is to indicate if the patient is pregnant.
Note: This section will appear only if the patient’s Birth Sex is marked as Female in the Demographic tab.
Pregnant?: Select Yes, No, or Unknown from the drop-down list.
Click +Pregnancy button to add pregnancy details.
[image: Image of pregnancy status]
Pregnancy Fields:
Number: Select pregnancy number for the female patient (e.g., if this is the person’s second pregnancy, select ‘2’)
Expected Delivery Date: Enter anticipated pregnancy delivery date.
Expected Delivery Facility: Enter name of the facility where the patient is expected to 
deliver and press Enter. Select from the list.
Actual Delivery Date: Enter delivery date when the patient delivered the baby/ babies.
Actual Delivery Facility: Enter name of the facility where the patient delivered the 
baby/babies and press Enter. Select from the list.
Insurance Mother: Select insurance status of the female patient.
Insurance Infant: Select insurance status of the baby/babies.
Outcome: Select pregnancy outcome from the drop-down (e.g., delivered, twins, etc.).

[image: Image of pregnancy status section]
If the facility name is not in the list, contact your system administrator.

Click +Pregnancy button to add another pregnancy for the patient.

Click Save & Continue button on the top right corner of the page.



Treatments: Treatments are speciﬁed by disease. Only treatments associated with the disease will be displayed. Select an option from the Treatment Given drop-down list. 

If additional treatments were administered, select the +Treatment button to display additional ﬁelds to add further treatment information.

[image: Image of treatments section]

Treatment Fields:
[bookmark: _heading=h.19c6y18]Treatment Date: Enter treatment start date.
Treatment Stopped Date: Enter the date when treatment was stopped.
Treatment: Select the treatment that was provided from the drop-down list. This list is disease speciﬁc.
Quantity: Enter treatment dosage amount.
Treatment Form: Select the treatment form from the drop-down list.
Status: Select whether the treatment was Administered or Prescribed.
Treatment Comment: Enter notes on treatment provided to the patient for future tracking.

[image: image of the treatments section]
If the treatment name is not in the list, contact your system administrator.



Vaccines: This section is to add vaccine details. It will only be visible in select records where vaccination status is relevant.

[image: Image of show vaccine data from IIS functionality] Note: As part of the ongoing EpiTrax enhancements, the system does interface with WebIZ.   





Utilizing the WebIZ interface:
· Select show vaccine data from IIS
· If the individual has a vaccine history then their demographic information from that system will appear, you have the option to accept that information by clicking Connect Person

Manually adding Vaccines:
Click +Vaccine button to display additional ﬁelds to add vaccine information and/or add another vaccine record for the patient.

Vaccine Fields:
Vaccine: Select the vaccine name. The list will be disease speciﬁc.
Administered Date: Enter vaccination administered date. 
Dose number in series: Enter vaccine dosage series number.
Manufacturer: Enter the vaccine manufacturer name.
Lot Number: Enter vaccine lot number.
Expiration Date: Enter vaccine expiration date.
National Drug Code (NDC): Enter vaccine NDC code.
Vaccine Record Identifier: Enter vaccination record ID number.
Information Source: Select vaccination information source from the list.
Vaccine comment: additional information about the vaccine.
[image: Image of vaccine section]
[bookmark: _Toc116472499]
EpiTrax Laboratory Tab

The Laboratory tab is the third tab in the Edit Morbidity Event page. This tab is to view the related laboratory results for the event. It can also be opened from the View -> Laboratory menu. 

If laboratory details come electronically, all fields will be filled out. If a facility is not in the system, contact your system administrator to add it. Click +Add Lab button to display additional ﬁelds to add lab information and/or add another lab record for the patient.
[image: Image of add lab button]

Lab fields:
Performing lab: Enter the lab name and press Enter, EpiTrax will search for closest match. Press Enter alone to search for all. Click on the correct choice.
Ordering facility: Enter letters in facility name and press Enter. EpiTrax will search for closest match. Press Enter alone to search for all. Click on the correct choice.
Ordering clinician: Enter name in order to search, press Enter for all. Click on the correct choice. If not found, select +New to add new clinician.
Patient address at collection: Select address from dropdown list (contains all addresses associated with the individual in the system).
Collection date time: Enter date, hours, minutes.
Specimen source: Select from the drop-down list.
Accession no: Enter accession number
Specimen sent to state lab? Select from the drop-down list.
[image: Image of laboratory section]

Tests section:
Test type: Select from the drop-down list.
Organism: Select from the drop-down list.
Test result: Select from the drop-down list.
Result value: Enter result value.Note: most lab messages, like the NTE segments, populate in the notes tab so please check there to see additional information.

Units: Enter type of unit.
Reference range: Enter reference range.
Test status: Select from the drop-down list.
Lab test date time: Enter date, hours, minutes.
Comment: Additional information regarding test.
[image: Image of tests section]

Susceptibility section:
Susceptibility: To add, select +Add Susceptibility

[image: Image of susceptibility section.]

[bookmark: _heading=h.3tbugp1]Antimicrobial agent: Select from drop-down list.Note: Some conditions will have additional susceptibility lab fields and they will appear below this section.

Result: Select from drop-down list.
Result value: Enter result value.
Test date: Add date of test.

[image: Image of susceptibilities]

[bookmark: _heading=h.3j2qqm3][bookmark: _Toc116472500]EpiTrax Contacts Tab

Contacts is the fourth tab in the Edit Morbidity Event page. This tab can also be opened from the View -> Contacts menu.

[image: Image of contacts tab]

Note: This section does not record contact information for the patient. It records people the patient may have exposed to an illness or the person(s) who exposed the patient to an illness, otherwise known as ‘contacts’.

The Contacts tab shows detailed information for persons or animals who have been in contact with the case patient during the infectious period of the disease. The collection of contact information allows the health department to track clusters or possible outbreaks, identify contacts at risk of spreading the disease, and to take public health action to reduce further exposure in the community.

Sections under this tab include:

Case Management:
    Symptom onset date 
    Infectious Period Start Date
    Incubation Period Start Date
    No Longer Infectious After
    Incubation Days
    Infectious Days
    Isolation Period End Date
Note: Symptom onset date is entered by the user. The remaining six fields are calculated by EpiTrax depending on the condition.

Adding Contacts: To enter information regarding the potential exposures. You first want to search for contacts.
Search Person: 
· Enter the last name and at least four characters of the first name of the contact person under Person name, OR
· Enter the last name and at least four characters of the first name in the Last name and First name fields
Click Search. 

[image: Image of contacts section ]
[bookmark: _heading=h.28h4qwu]
Search criteria are used in calculating a score, and the highest scores are displayed at the top. If the person is found by performing a search, click + Contact under Action and click on Save & Continue on the upper right to add that person to the case record as a potential exposure.

[image: Image of add contact button]


[image: Image of adding contacts]Link to an orphan contact with a record number: When a CMR is demoted to a contact, that contact’s record is an “orphan” (not connected to a Morbidity Event). The number can be entered into the Link to an orphan contact with a record number ﬁeld. Click on Save & Continue on the upper right. The record will now be an associated contact record for the parent patient.


If the person is not found, click + Create Person and Contact button by the side of the ﬁeld and add contact’s details.
[image: Image of create person and contact button]


[bookmark: _heading=h.nmf14n]Import: Importing contact demographic information into EpiTrax begins by clicking on the Import button. Contacts may be entered into an Excel file. When Leave Site window pops-up, select Leave. 
[image: Image of import button]
From the Event Import page, click on the Options menu item.

Download Template: Click on Download Template to download the predefined template as an Excel file. Save the template on your computer.

[image: Image of event import]

Open the ﬁle - all the header ﬁelds will be set in the top row and should not be altered. Enter data in subsequent rows in the .XLSX ﬁle, one row for each contact. Save it in a secure location.

Once the file has been created:
A. Upload Import File: Click on Upload Import File. Under Import File, select Choose File to navigate to the appropriate document. 
B. Choose the Contact Event Type.
[image: Image of the event import upload import file feature]      [image: Image of the event type dropdown]A
B



To finish importing, click on Import.


Imported contacts have been added to the parent patient.

[image: Image of imported contacts ]

Click on parent patient record number in the top left to return to the parent patient record.
[bookmark: _heading=h.4i7ojhp]

[bookmark: _heading=h.37m2jsg][bookmark: _Toc116472501]EpiTrax Encounters Tab

The Encounters tab will be mostly used by investigators doing case management to track when and where a case had encounters (i.e., contact) with public health.

To add an Encounter, select the +Encounter button:

[image: Image of encounter section]

Encounters Section:
Investigator: This ﬁeld will auto-ﬁll with the investigator’s name that is completing the CMR. If you need to change the name, you may click on the ﬁeld to view and select from the drop-down list of investigators.
Encounter date/time: This ﬁeld is used to enter the date and time of the encounter with public health.
Location: This ﬁeld contains a drop-down listing the types of methods through which the public health encounter may have occurred. Select the appropriate option from this ﬁeld.
Outcome: a drop-down list of possible outcomes.
Description Field: This ﬁeld allows the investigator to enter additional information which may describe the speciﬁed encounter.

[image: Image of encounters section]
Note: Some conditions will have additional encounter related fields (e.g., patient notification or follow-up documentation) and they will appear below this section.

Click on Save & Continue on the upper right
[bookmark: _heading=h.1ci93xb]You can now add an additional Encounter or a Follow-up Encounter.



[bookmark: _Toc116472502]EpiTrax Investigation Tab
The Investigation tab is made up of several sections: Associated Forms or Investigation form, contact oriented, exposure, travel, and other.

Investigation Form: 
These forms allow the system to collect information that varies by condition or condition group.

For many infectious diseases, there will be no ﬁelds displayed in the investigation form section under the Investigation tab. If additional tabs do appear, you will need to complete all ﬁelds displayed. Fields will be displayed in a micro-tabbed format.

[image: Image of investigation tab]

[image: Image of investigative information]Note: If you receive the message “No investigation forms are configured for this event and/or disease”, your CMR was entered correctly, however that disease has no associated forms to complete. You can always confirm there are no forms by selecting Manage. This will allow you to select the forms that you wish to add or remove. 
[image: Image of investigation tab, specifically teh forms. This image shows that one form can have a lot of tabs.]
In some circumstances, multiple forms may be required to investigate a case. Additional forms currently added to the case can be viewed by reviewing the Associated Forms section on the left-hand side of the Investigation tab.

[bookmark: _Hlk109307004]To add a form, or to remove a form you do not need, click on Manage. This will allow you to select the forms that you wish to add or remove.

When you click on a form listed in the Associated Forms section, you will see tabs displayed on the right. You may use these tabs to complete investigations regarding the case. These forms are often the same as the paper (PDF) versions of the disease speciﬁc forms.

Contact Oriented: 
[image: Image of contact oriented section showing the healthcare worker options ][image: Image of contact oriented question]This section provides fields to note whether this case is a food handler, healthcare worker, associated with group living, or associated with day care. This also provides a field to note the occupation of the case. 


Note: some conditions will require more information if “yes” is selected. 








Exposures: 
This section contains fields to record places where the case had been exposed. 

To add an exposure, click +Exposure button.

[image: Image of the exposure section]
Exposure fields: 
Exposure Place: You can search for a previously entered exposure place by typing a place name, city or zip code and then pressing Enter. If the place is not in the system, add it by pressing the +New button. After adding a new exposure, select the Save Exposure Place button. 
	Beginning: This is the date and time the potential exposure began.
	Ending: This is the date and time the potential exposure ended.
	Description: open text field to document the exposure.

[image: Image of exposures section]

Travel Section: 
This section allows you to record travel locations and dates. 

To add Travel, click +Travel button. 

[image: Image of the travel section ]








Travel fields: 
	Country: Specify country of travel.
	State: Specify state of travel if travel occurred within the United States.
	County: Specify county of travel if travel occurred within Nevada.
	City: Specify city of travel.
	Start Date: Specify the date travel began.
	End Date: Specify the date travel ended.

[image: Image of the travel section including country, state, county and city]	

Other fields: 
The Other section is used to input other important data of where the disease was contracted, how it was transmitted and what risk factors are involved. This section can vary depending on the disease condition.	
[image: Image of the "other" section at the bottom of the investigation tab]

\


[bookmark: _heading=h.2bn6wsx]

[bookmark: _Toc116472503]EpiTrax Notes Tab
Sections under this tab include: Attachments and notes.

Attachments: 
A new attachment can be added by selecting the +Attachment button on the right.
[image: Image of the attachment section]

Notes:
A new note can be added by selecting the +Note button on the right.
[image: Image of add note section]

There are two types of notes:
Administrative: System added notes that are created when certain actions take place within the case. Including notes of HL7 messages when an ELR is added to the case.Note: A note that has been saved is PERMANENT. It cannot be deleted; however, you may use the strike-through option to indicate that the note is no longer valid.


Clinical: Notes added by a user to record data that cannot be entered on any other tabs.
[image: Image of notes section]
Helpful tips regarding Notes:
· The available font options, in order, are:
Bold, Italic, Underline, Strikethrough, change of font type, change of font size, font color, and highlight.
· Users can create a bulleted list, a numbered list, indent a sentence or paragraph, change to right, left or center justiﬁed, hyperlink, or set text back to default.
[bookmark: _heading=h.3as4poj][bookmark: _Toc116472504]EpiTrax Tasks Tab
Tasks is the eighth tab in the Edit Morbidity Event page. This tab can also be opened from the View -> Tasks menu. 
[image: Image of tasks tab ]

Displays system generated and person created tasks for the CMR record. 
Click on “+Add Task” in the right.
[image: Image of the tasks section]

Fill out all task information as displayed. Click on Save in the lower left. The task will now be displayed at the bottom of the Notes tab. It will also display on the dashboard after logging into EpiTrax. 

[image: Image of the add task section showing all the task fields]

[bookmark: _Toc116472505]EpiTrax Administrative Tab
Administrative is the last tab in the Edit Morbidity Event page. This tab can also be opened from the View -> Administrative menu. 

The Administrative tab allows users to input additional information regarding the case.
[image: Image of administrative tab]

Sections under this tab include: Event Information, Reporter Information, Case/Outbreak, Auditing/Investigation.
[image: Image of administrative tab]

Fields available in the Administrative Tab include:Note: In addition to the core fields outlined here, there may be additional fields in this section depending on the condition. Identification Type shown above is one example of this.

LHD Case Status: Completed by LHD based on LHD protocols.
[bookmark: _heading=h.1mrcu09]State Case Status: Completed by state.


Outbreak Associated: Completed by LHD or state if the case has been identiﬁed as being associated with an outbreak. If you are trying to assign an outbreak that is not yet listed, email NVEpitrax@health.nv.gov to have it added.
Outbreak Name: Completed by user when an outbreak is currently being investigated. Only existing outbreak events associated with the disease condition will be available in the drop-down list. To add an outbreak name, contact your system administrator.
Auditing / Investigation: These ﬁelds are to be completed at the LHD based upon LHD protocols. 
Reporting Agency and Reporter Fields: These ﬁelds reﬂect the entity and individual reporting the disease incidence to Public Health.





[bookmark: _Toc116472506]Person


 

Persons are central to EpiTrax. The Edit Person menu item allows us to connect to demographic information, morbidity events, clinical information, laboratory records, and travel regarding the person, as well as adding information regarding external systems. 

There are several ways to access Edit Person. 
1. From within an event, you can select Edit Person from the options menu. When choosing Edit Person, the “Leave Site” window will pop-up. Select Leave.

[image: Image of options dropdown]


2. From the main menu you can navigate to People, and this allows you to search for a person.
A. Select People – At least four letters from the first and last name are needed. If the first or last name is less than four letters, then all letters are needed.
B. Enter information into search criteria
C. Select Edit Person
· [image: Image of edit person ]C
A
B



3. Each person is assigned a unique system ID. You can pull up a person record by inserting the system id into the end of the URL. Emailing the system ID would be a confidential way of sharing information. 

[image: Image of the system id]


https://test.epitraxnv.org/nedss/person/view/15849685
Demographic TabNote: This is the testing URL so please be aware that there may be slight changes to the live production URL. 

[image: Image demographic tab from the edit person section ]

Demographic Fields:
Name: The last name and ﬁrst name of the person will be auto populated
Age: 
Date of birth: The ﬁeld will be auto populated if entered during creating the new CMR for the person. Add the date of birth if the ﬁeld is empty.
Current Age: Values will be auto calculated based on the date of birth entered for the person and the current date. 

Mortality Status: 
Died?: Select from the drop-down list.
Date of death: Enter date of death if applicable. 

Addresses:
	If address is not already entered from original CMR, select +Enter Address.
	Street: Enter the house number and street name (e.g., 123 Generic Street).
Unit Number: Enter the apartment, space or unit number or the multi-family housing complex number, if applicable. 
	City: Enter the full city name, unabbreviated.
	State: Select the state by clicking the drop-down arrow.
	Zip Code: Enter the 5-digit zip code.
	County: Select the county by clicking the drop-down arrow.
	Earliest Known: Enter the date when the address became valid for the person.
	Moved: Enter the date when the person moved from the given address.

Telephones: This section is for adding the contact information for future follow-up with the patient. Multiple telephone numbers can be added.
Telephone Type: Select the telephone type of the phone from the drop-down list.
Area Phone, Ext: Enter the area code, phone number and extension. Extension is optional.
Country: Enter country code. For the USA, enter 1.
Earliest known: Enter earliest known date person had this phone number
Note: Additional information regarding phone.
To save, click Save & Continue button on the upper right. This will bring empty fields for an additional telephone number.

Email Addresses: This section is for adding the contact information for future follow-ups with the patient by email. Multiple email addresses can be added.
Email Address: Enter email address.
To save, click Save & Continue button on the upper right. This will bring up another empty field for an additional email address.

Demographics: This section is for adding additional demographic information for the patient.
Birth Sex: Select the birth sex of the person.
Current Gender: Select the current gender of the person.
Primary Language: Select the primary language of the person.
Ethnicity: Select ethnicity from the drop-down list.
Race: Select the race values from the check box list (may check more than one).
Country of Birth: Select the country of birth from the drop-down list.

Click Save & Continue button on the upper right.


[bookmark: _Toc116472507]Events Tab
The Events tab has under it the morbidity events associated with this person. 

[image: Image of the events tab associated with the person ]

You can access Events by selecting the record number or using the Options menu. 
[image: Image of the events ]

 To add another, select +Create CMR in the upper right. 

[image: Image of the events tab]


Please note that it is very easy to create a duplicate CMR unless care is taken to avoid it. If this is indeed a new morbidity event, begin with the following steps:

A. First reported to public health: enter the date first reported.
B. Disease: select from the drop-down list.
C. Investigating Agency: select from the drop-down list.
D. Click Save & Continue.
[image: Image of the new cmr section]A
B
C

This takes you to the Edit Morbidity Event page.



[bookmark: _Toc116472508]Clinical Tab
The Clinical tab shows historical information. To add clinical information, go to the EpiTrax Clinical Tab of the Edit Morbidity Event section.

[image: Image of facilities and clinicians section]

[bookmark: _Toc116472509]Laboratory Tab
The Laboratory tab shows lab tests, if any, that the person has had. To add lab tests, go to the EpiTrax Laboratory Tab of the Edit Morbidity Event section.

[image: Image of an example of the laboratory fields ]
[bookmark: _Toc116472510]Travel Tab
The Travel tab shows all travel that the EpiTrax user has recorded for the case investigation, if any.

To add travel for the person, click the +Travel button in the upper right.
[image: Image of the travel tab]

Travel Fields: 
Country: Select country from the drop-down list. 
State: Will be grayed out until a country is selected from the drop-down list.
County: Will be grayed out until a state is selected from the drop-down list.
City: Enter the name of city/town.
Start date: Enter start date of the travel.
End date: Enter end date of the travel.
Click on Save & Continue on the upper right to continue or Save & Exit to exit.




[bookmark: _Toc116472511]Administrative Tab

To add an external system, click the Add External System button on the upper right.
[image: Image of the administrative tab]
External Systems: 
External system: Select external system from the drop-down list. 
	Person identifier: Enter the person identifier in the external system.
	Click on Save & Continue on the upper right to continue or Save & Exit to exit 



[bookmark: _Toc116472512]Events
[bookmark: _Events_Management]

 

[bookmark: _Toc116472513]Events Management
The Events section within EpiTrax allows users to establish filters (or search criteria) to display a list of certain events. You can use these filters to view a list of new cases and/or contacts assigned to your jurisdiction by the state or other jurisdictions. You can create and save multiple Events views/lists.
The Workflow Feature Workflow Status Color Coding:
Gray – Accepted by LHD
Green – Under Investigation
Pink – Assigned to LHD




The Workflow feature in EpiTrax updates when certain actions are completed. When staff enter a case and route it to an agency, Workflow Status is set to Assigned to LHD. 

When an LHD receives and accepts the case, the Workflow Status updates to Accepted by LHD. This means that any new cases that have been assigned to an LHD but have not been acted upon will have the Assigned to LHD status. 

Cases still in Assigned to LHD status are shaded in pink. These are the new cases. If you have not set any filters on your Events page, these new cases will be mixed in with other cases. 

[image: Image of the events tab]
Contact vs. Morbidity
Yellow – Contact Record
Green – Morbidity Record



Additionally, the colors along the left hand side note if the event is a contact record (yellow) or a morbidity record (green). This is also noted next to the record number.
[bookmark: _Hlk109385077]

Setting up a View: New Cases

Unlike with setting up views for tasks, you can have multiple Event views saved. 

Users can filter on the following criteria: Record Number, Last Name, First Name, Age Range, Event Date After, Event Date Before, Event Type, Event Investigation Status, Queues, Investigator, Diseases, Investigating Agency, State Case Status, Language, Address at Diagnosis, Facility, and Show Deleted Events

One option would be setting up a view to see only the new cases. 
1

1. Click Events
[image: Image of the dashboard specifically showing the events]

2. Click Options2

[image: Image of the options button]
3. Click +Add View

[image: Image of the add view button]3


Make selections in the expanded options box. This is an example for selecting new COVID-19 events, but you could set up Event views for anything and have the filter saved to your profile. 
Selections:
A. New View Name: New COVID Cases (these are only accessible from your account so please use whatever nomenclature you prefer)
B. Event Type: Morbidity
C. Event Investigation Status: Assigned to LHD
D. Investigation Agency: SNHD Diseases
E. Diseases: Novel Coronavirus
F. Click Save

[image: Image of events] C
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The Events list will now display all your new cases. You only need to set up and save this query once. When you want to pull your list of new cases, return to the Events tab and select your saved New COVID Cases from the Current View list.
[image: Image of current events ]

Along the left side of each record is a color bar. Green indicates a morbidity record while yellow indicates a contact record.






Updating and Deleting a View

You can update or delete a view using the More Options button.
[image: Image of the options available for updating or adding a view]

Setting up a View: New Contacts
To view new Contact events in the Events page, you can set similar filters following the steps below: 
A. Repeat steps 1-3 from Setting up a View: New Cases (above)
B. New view name: New Contacts (please use whatever nomenclature you prefer)
C. Event Type: Select Contact
D. Event investigation status: Assigned to LHD 
E. Diseases: COVID-19
F. Investigating Agency: Select your agency
G. Click Save

[image: Image of events, specifically the fields necessary for setting up a new cases event view]F
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The Events list will now display all your new contacts. You only need to set up and save this query once.

[image: image of the results from the event view setup]


Using Bulk Workflow Function 

On the top right side of the Event View page, you can transition the workflow of multiple events simultaneously.

Use check boxes to select events. Then select the bulk workflow action.
[image: Image of the bulk workflow options]



Note: Will only work if the selected events are in the same stage of workflow. For example, you could select several events that have been Assigned to LHD and accept them at once. 










[bookmark: _Toc116472514]EpiTrax Exports

 





[bookmark: _Toc116472515]Creating and Running Reports
Folder Structure
[image: Image of saved exports]
There are two types of folders: 
· Drafts: use this for personal reports.  
Example: QA reports for management
· Public Exports: use this for jurisdiction wide reports.
Example: Reports used by more than one team member


Folder Organization
All jurisdictions have a respective folder: 
· HAI
· WCHD
· OPHIE
· Great Basin Community College
· CCHHS
· Office of Analytics
· Rurals
You can add subfolders as needed, but all reports used by your jurisdictions should be stored in your respective root folder.

Existing Reports:
All out of the box reports are stored within the OPHIE folders by disease areas:
· Influenza
· Foodborne and Diarrheal
· Hepatitis
· STD
· VPD
· Lead and Heavy Metals
· TB
· COVID
· Arboviral & Vector borne Diseases
· GCD
Each disease group should contain a de-identified DataMart for each of the diseases included within the group. Locals my copy any of these reports to their respective folders for further customization to their jurisdiction.

Creating a New Report
1. Click into the folder you want to put a report in
2. Click the New Export button 

[image: Image of saved exports]

3. Select the condition(s) you would like to include in the report. 
[image: Image of diseases dropdown options]
4. Click into the Columns tab
5. Click the dropdown next to the Core Columns to see all variables
[image: Image of reporting variables ]6. Select the reporting variables you would like included in your export6..
5..

7. After selecting all of your variables, select save.
[image: Image of the save button]

8. Click into the filter box to populate options
9. Enter required filters
[image: Image of report filters]

10. click Export to run your report 
[image: Image of the export button 
] 
[bookmark: _Toc116472516]Appendix

 










[bookmark: _Toc116472517]Definitions
[bookmark: bookmark=id.111kx3o][bookmark: _heading=h.2lwamvv]Accordion View:
An accordion menu is a vertically stacked list of menu choices that can toggle by being clicked to reveal or hide content associated with them
Carrier: 	
Individuals who harbor an infectious agent but are asymptomatic
Case:
 A person with the particular item of interest or disease; an alternate name for the CMR or record
[bookmark: bookmark=id.206ipza][bookmark: _heading=h.3l18frh]CMR: 
Conﬁdential Morbidity Report
Conﬁdentiality: 
The obligation to not disclose identifying information unless needed to protect the public’s health, as allowable by state law or regulations
Conﬁrmed Disease Outbreak: 
A disease outbreak in which laboratory analysis of appropriate specimens conﬁrms a causative agent and epidemiologic analysis implicates the source of the illness and that the magnitude of disease spread is determined to be high enough by the health authority to constitute an ‘outbreak’
Contact: 
A person the patient may have exposed to an illness, or a person who exposed the patient to an illness
[bookmark: _heading=h.4k668n3][bookmark: bookmark=id.2zbgiuw]CSV:. 
A Comma Separated Value file is a widely used standard for storing and transmitting data. They contain rows (numbered) and columns (designated by letters) of data separated by commas. The top row is unique. It holds the column headings and must not be changed. Microsoft Excel understands CSV files. CSV files can be opened and edited in Microsoft Excel. Data can be changed or add new rows (any cell can be blank, that is not a problem), and the file can be saved in a secure location for upload or other future use. It is very important not to put a comma in the data or programs accessing the file will not understand the contents of the CSV file. These files can serve as reports or be displayed meaningfully by various software.
[bookmark: bookmark=id.1egqt2p]Demoted:
This may arise when a person who was believed to have an infectious disease is shown not to.
[bookmark: bookmark=id.3ygebqi]eCR:
Electronic Case Report
ELR: 
Electronic Laboratory Report
Encounter:
The interaction between a patient and a public health oﬃcial

Epidemiology: 
The method used to find the causes of health outcomes and diseases in populations. The study (scientific, systematic, and data-driven) of the distribution (frequency, pattern) and determinants (causes, risk factors) of health-related states and events (not just diseases) in specified populations (neighborhood, school, city, state, country, global). Source: CDC
[bookmark: bookmark=id.2dlolyb]Excel Files:
Excel files in their native format have the extension .XLSX. EpiTrax can download a template whose top row includes headings for the data. Subsequent rows may be filled in with data on a Morbidity Event or a Contact Event. The resulting file can be saved and imported into EpiTrax. This feature could come in handy for an investigator in the field where there is poor Internet connection. The data can be entered at the time and then imported into EpiTrax later. It can also be used to conveniently enter multiple Events – note that all the Events in a given file must be all Morbidity Events or all Contact Events.
Food Establishment: 
An operation that stores, prepares, packages, serves, vends, or otherwise provides food for human consumption
Foodborne Illness: 
A disease acquired through eating or drinking contaminated food or liquids 
[bookmark: bookmark=id.sqyw64]HL7:
Health Level Seven or HL7. A set of international standards for transfer of clinical and administrative data between software applications used by various healthcare providers and organizations.
Public Health Surveillance:
The routine collection, analysis, summarization, and dissemination of data for the purpose of preventing and controlling the spread of disease
Risk Factor: 
An attribute or exposure that is associated with an increased occurrence of disease or other health-related event or condition
[bookmark: _heading=h.3cqmetx][bookmark: bookmark=id.1rvwp1q]Tab View:
A horizontal menu of tabs that can be selected to show the items under the tab.
[bookmark: bookmark=id.4bvk7pj]XML:
eXtensible Markup Language. A widely used standard for sending messages between applications. Like Hypertext Markup Language (HTML, the language of the web) it uses opening tags/closing tags to mark off data. Unlike HTML, these are not limited to a predefined standard. HTML’s purpose is to display data. XML’s purpose it to transmit data. 



[bookmark: _Toc116472518][bookmark: _Hlk109288488]Case Routing Workflow

1. Once a Confidential Morbidity Report (CMR) has been created within EpiTrax, it will be assigned to a Local Health Department (LHD). 
2. The LHD will receive notiﬁcation that the new case has been assigned to their jurisdiction. The CMR will appear in the Local Health Department events list.
3. Upon receiving the notiﬁcation, the LHD will review the case and determine if it was assigned to the correct jurisdiction. 
(a) If the patient’s address is NOT in the jurisdiction of the LHD, the LHD will review to see if the provider is in the LHD’s jurisdiction. 
(b) If the provider is in a county that is covered, the LHD will contact the provider to obtain the patient’s information. 
(c) If the provider is NOT in a county covered, the LHD will review the CMR to see if the laboratory is in the LHD’s jurisdiction. 
(d) If the laboratory is within the LHD’s jurisdiction, the LHD will contact the lab to obtain patient information. 
(e) If the patient is not in the LHD’s jurisdiction, the LHD will update the address, create and save a note, and reroute the case to the appropriate jurisdiction. 
(f) If the case is an out-of-state case, the LHD will re-route the case to the Out of State agency. (Please note that most out-of-state cases will be appropriately routed by EMSA and will not populate in Epitrax) 
4.   Once it is determined that the case is in the correct jurisdiction, the LHD will click on    ‘Accept’  to  accept  the  CMR.  This will  change  the  status  to “Accepted by Local Health Department”. 
5.   In the  “Assign  to  investigator”  drop-down list,  the  LHD  will  assign  the  CMR  to a specific disease investigator and change the status to “Assigned to Investigator.” Alternatively, the LHD may “Assign to queue” on the Administrative tab based on the protocols established by the LHD. 
6.   Once the case is assigned to an investigator or a queue, it must again be “Accepted”. This will change the status to “Under Investigation”. 
7.   Once the investigation is completed, the LHD investigator will click the “Complete Investigation” button. 
8. The LHD Administrator or investigator (depending on jurisdictional workflow) will then select “Approve at LHD”.
8. To officially close the case, the LHD administrator or investigator (depending on jurisdictional workflow) will then select “approve at state”.


[bookmark: _Toc116472519]EpiTrax Flowchart
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